Most professional typographers cringe when they look at Web pages because Web browsers default to Times Roman, and most sites use the default font. Adding to the frustration is the fact that type appears differently on Mac, Windows, and UNIX platforms.

Dreamweaver MX gives you many hooks and handles for making the best of this situation. This chapter covers how to set font styles (such as **bold**, *italics*, and _underlined_), font sizes, font colors, and font faces (such as Times Roman, Helvetica, Arial, etc.). It also covers making bulleted lists, definition lists, and unordered lists. If you haven't heard those terms before, they will also be explained here. There is a great feature in Dreamweaver MX: the ability to add Flash text. This feature allows you to use any font or style you want without worrying about how it will appear on other platforms.
CSS versus FONT Element

The first part of this chapter describes how to use font formatting in Dreamweaver MX that utilizes (behind the scenes) HTML called the FONT element. The Web Standards Organization (http://www.w3.org) has eliminated the FONT element from the formal HTML specification, but it is still used on many new and old Web sites. We advocate that you use CSS (Cascading Style Sheets), which you will learn about in Chapter 11, “Cascading Style Sheets,” instead of the FONT element as you begin to code your real site. This chapter is an intermediate step toward building better type skills. It teaches you how to use Font styles, and some of the information you learn here will be very similar to what you will learn in the CSS chapter. We could have eliminated this chapter altogether, but chose not to so you could see both ways of formatting text. Because the FONT element is no longer part of HTML, there is a strong chance that future browsers will not support it. Today, browsers do support this tag, but there is wide speculation that some day they will not.

A Word About FONT FACE

The FONT FACE element in HTML allows you to specify a typeface other than the end user’s default font. You can apply the attribute in Dreamweaver MX by creating font lists, which are described in the following exercise. Font lists are also used in CSS, so this knowledge will apply to future chapters as well. The caveat is that the typeface must be installed on your end user’s system, or the browser will not be able to display it. It might come as a surprise that HTML text uses different sizing conventions from traditional print type sizes. Actually, all HTML text has a default size of 3, with a total range from 1 to 7.
6. Typography | Dreamweaver MX H•O•T

**HTML Default Text Size**

<table>
<thead>
<tr>
<th>Font Size Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Original base font size of 3</td>
</tr>
<tr>
<td>1</td>
<td>Font size 1</td>
</tr>
<tr>
<td>2</td>
<td>Font size 2</td>
</tr>
<tr>
<td>3</td>
<td>Font size 3</td>
</tr>
<tr>
<td>4</td>
<td>Font size 4</td>
</tr>
<tr>
<td>5</td>
<td>Font size 5</td>
</tr>
<tr>
<td>6</td>
<td>Font size 6</td>
</tr>
<tr>
<td>7</td>
<td>Font size 7</td>
</tr>
<tr>
<td>+1</td>
<td>Font size +1</td>
</tr>
<tr>
<td>+2</td>
<td>Font size +2</td>
</tr>
<tr>
<td>+3</td>
<td>Font size +3</td>
</tr>
<tr>
<td>+4</td>
<td>Font size +4</td>
</tr>
<tr>
<td>+5</td>
<td>Font size +5</td>
</tr>
<tr>
<td>+6</td>
<td>Font size +6</td>
</tr>
<tr>
<td>+7</td>
<td>Font size +7</td>
</tr>
<tr>
<td>-1</td>
<td>Font size -1</td>
</tr>
<tr>
<td>-2</td>
<td>Font size -2</td>
</tr>
<tr>
<td>-3</td>
<td>Font size -3</td>
</tr>
<tr>
<td>-4</td>
<td>Font size -4</td>
</tr>
<tr>
<td>-5</td>
<td>Font size -5</td>
</tr>
<tr>
<td>-6</td>
<td>Font size -6</td>
</tr>
<tr>
<td>-7</td>
<td>Font size -7</td>
</tr>
</tbody>
</table>

To change HTML text to a size other than the default of 3, you can either specify a number from 1 through 7, or + or - 1 through + or - 7 relative to the BASEFONT size (which is 3). For example, if you want your HTML text to be size 6, specify the font size to be 6 or +3. Either setting produces an HTML type of size 6. Some browsers let you set the BASEFONT for a page by using `<BASEFONT size = "4">`. You can specify any size you want, using one of the above-mentioned methods.

The illustration above shows an example of the Font Size settings in Dreamweaver MX. The top example, None, is the equivalent of Font Size 3. Notice how the type does not look different in Font Size +4 through +7, or Font Size -2 through -7? There is no difference between these settings.
Adding and Formatting HTML Text

In this exercise, you will learn how to add HTML text to a Web page. You will also learn how to format this text by modifying the typeface, size, style, and other attributes. As you will see, creating and formatting HTML text with Dreamweaver MX is just as easy as working with any word processing application.

1. Copy chap_06 from the H•O•T CD-ROM to your hard drive. Define your site for Chapter 6 using the chap_06 folder as the local root folder. If you need a refresher on this process, visit Chapter 3, “Site Control.”

2. Open the index.html file. This is the home page of bonsaihut.com, but it doesn’t have text navigation. You are going to add this next.
3. Open the **Page Properties** by choosing **Modify > Page Properties**. Notice that we have already set the text color properties for this page. This is an important issue to point out because as you add text and create links on this page, they will take on the color settings specified in this dialog box.

4. Click to the right of the **Contact Information** image and press **Return/Enter**. This will insert a paragraph break tag and create an extra line of space between the text and the image above.

5. Type **home | art of bonsai | how to bonsai | tools & supplies | resources | photo gallery | contact information** and press **Shift+Return/Enter**. Remember, you create the | character by pressing **Shift+backslash**.
6. Type *visit treebay.com to learn more about bonsai*.

7. Select the words *art of bonsai*.

8. In the **Property Inspector**, choose the **Font List** pop-up menu and select the **Verdana, Arial, Helvetica, sans-serif** option. This will change your text to Verdana if you have that font installed; if you do not, Dreamweaver MX will display the next font in the list.

9. With *art of bonsai* still selected, in the **Property Inspector**, choose the **Size** pop-up menu and select **2**. This will change the size of your type.
10. Go to the Size pop-up menu again and select -1. Notice how the type size stays at 2. That’s because all HTML text has a basefont size of 3, from which you add or subtract to make your type larger or smaller.

11. Select the words *how to bonsai*.

12. From the Property Inspector, choose the Text Color Box. Select a bright red color. Your text color is now red. This setting will override any text color that you might have specified under Modify > Page Properties.

13. Select the words *tools and supplies*.

14. In the Property Inspector, click the Bold button. This will make the selected text bold.

15. In the Property Inspector, click the Italic button. This will make the selected text italic.

16. Save and close the file.
What Are Headings?

HTML text can also be formatted using Heading tags. The tags look like this: \texttt{<H1>}. They range from 1 to 6 and change the size of the HTML text. Here's a tricky thing that you might want to remember: The smaller the number next to the H, the bigger the text will be. For example, \texttt{<H1>} will produce the largest text, whereas \texttt{<H6>} will produce the smallest text. Generally, the \texttt{<H1>} through \texttt{<H6>} tags insert a line break before and after the text without requiring additional code. Heading tags can be useful for formatting large text.

Why might you use a Heading tag instead of a \texttt{FONT SIZE} element? Accessibility! If sight-impaired users access your Web page, they might not “see” your Web page, but will instead have a reading device “read” it aloud. Heading tags can be “read” by HTML readers as headlines, whereas large type, formatted with the size attribute, is given the same emphasis as body copy. You might not imagine that your site has much of a sight-impaired audience, and perhaps do not think this information applies to your site design strategy. In many cases, however, making your site accessible is not an option, but a requirement. Our advice is to use Heading tags instead of large font sizes for headlines. In addition, Heading elements can be used in CSS, so this information applies to future chapters as well.

This image shows the range of how Heading tags display in a browser.
2. **Font Lists**

In this exercise, you will learn how to add and modify the *font lists* that come with Dreamweaver MX. By specifying multiple fonts using a font list, the likelihood of visitors seeing the page in one of the typefaces you specified is higher, because you’re offering more than one choice. You will learn how to modify what typefaces are in the existing font lists and how to create your own custom font list. Learning and using this technique will allow you to break out of the Times Roman mold a little bit, which is a welcome enhancement to the bland Web type landscape we all see every day. Font lists are also used in CSS.

1. Open **text2.html**.

2. Select the words *This is the Arial, Helvetica, sans-serif font list*

3. From the **Font List** pop-up menu in the **Property Inspector**, choose **Arial, Helvetica, sans-serif**. This will change your text to Arial if you have that font installed; if you do not, it will go to the next font in the list.
NOTE | How Font Lists Work

Font lists are a very useful way of ensuring that the HTML text on your Web page is viewed the way you intended. A Web browser will search for each font in the list until it finds one that is installed on the end user's system. Once it finds a font in the list, it will use that font to display the HTML text on your Web page. For example, if your font list were "Arial, Helvetica, sans-serif," the browser would try to use Arial first to display text. If the end user did not have Arial installed, the browser would then try to display Helvetica. If it could not find Helvetica, it would then display the first sans-serif font it found. The goal of font lists is to create sets of fonts that have similar structure and characteristics, so that there is minimal change from viewer to viewer.

4. Select the words This is the Times New Roman, Times, serif font list.

5. From the Font List pop-up menu, choose Times New Roman, Times, serif. This will change your text to Times New Roman if you have that font installed; if you do not, it will go to the next font in the list.

6. Select the words This is the Courier New, Courier, mono font list. From the Font List pop-up menu, choose Courier New, Courier, mono. This will change your text to Courier New if you have that font installed; if you do not, it will go to the next font.

Are you getting the idea about how this works yet? ;-) 

7. Select the words This is the Georgia, Times New Roman, Times, serif font list. From the Font List pop-up menu, choose Georgia, Times New Roman, Times, serif.
8. Select the words **This is the Verdana, Arial, Helvetica, sans-serif font list**. From the Font List pop-up menu, choose **Verdana, Arial, Helvetica, sans-serif**.

![Font List](image)

This is what your page should look like now.

9. Click off the text to deselect it, and press **Return/Enter**. Below the last sentence on the page, type **This is my very own font list**.

![Font Properties](image)

10. From the Font List pop-up menu, choose **Edit Font List**.
11. In the **Edit Font List** dialog box that appears, select *Arial, Helvetica, sans-serif* from the **Font List** option. Select *Arial* under **Chosen Fonts**, then click the >> button to remove Arial from this font list.

12. Select *Arial Black* under the **Available Fonts** option. Click the << button to add this to the selected font list. You have just modified the fonts that will be used for this font list.
6. Typography | Dreamweaver MX H•O•T

13. Select **(Add fonts in list below)** from the bottom of the **Font List** field.

14. Select **Century Gothic** under **Available Fonts** and press the `<<` button to add this to your list.

15. Select **Verdana** under **Available Fonts** and press the `<<` button to add this to your list.

16. Click **OK** to add your new list to the font list.

17. In the **text2.html** file, select the words **This is my very own font list**.
18. From the **Font List** pop-up menu, choose **Century Gothic, Verdana**. This will change your text to Century Gothic if you have that font installed; if you do not, it will go to Verdana.

This is what your screen should look like now. This exercise gives you an example of how these font lists will display on your computer system. What you see might appear differently on other people's browsers, because they might have different fonts installed on their systems than you do.

19. **Save** and **close** the file.
Unfortunately for all of us well-intentioned Web publishers, HTML type appears much larger on Windows than it does on the Mac. Although they both display images at 72 dpi (dots per inch), Windows displays type at 96 dpi, whereas the Mac displays it at 72 dpi. This deceptively small technical difference results in much larger type on Windows.

The images above illustrate the difference in size between the two platforms. Pretty scary, huh? There is no solution to this, except to turn to Style Sheets (see Chapter 11, “Cascading Style Sheets”) to size your text by using pixels, but that works only on 4.0 version and later browsers.

To compensate, we often make type smaller at -1 or -2 when we are developing pages, but doing so only results in a more appealing Windows version, and a less appealing Mac version. Ugh! The theory is that there are more Windows users than Mac users, so we’ve taken the tack to make the type on our pages look acceptable on Windows, and slightly small on Macs.

One other solution to the size difference issue is to use images of text instead of HTML text. Because images display at 72 dpi on either Mac or Windows, the type will look identical on either platform. Later in this chapter, you’ll learn to make Flash Text, which generates an image using the SWF file format. The downside is that images are larger in file size than corresponding HTML text, and are not searchable by search engines. It’s always one gotcha or another, right?
Aligning Text

In this exercise, you will learn how to align text on the page. Unfortunately, HTML does not give you much control over aligning text. You have three basic options: **Left Align, Center Align, and Right Align**. You do have some extra options when you align text next to images, which you will also explore in this exercise. If the limitations of HTML alignment features frustrate you, that’s understandable. You’ll learn about more exact layout techniques in later chapters.

1. Open **text3.html**. Notice that the two lines of text at the top are left aligned. This is the default alignment setting for text.

2. Click anywhere within the sentence that reads, *This page will show you examples of different bonsai styles.*
3. In the **Property Inspector**, click the **Align Center** button. This will center your text on the page. **Note:** The centering of the text is relative to the width of the browser window.

4. Click anywhere within the sentence *If you would like to submit a photo, please let us know!*  

5. In the **Property Inspector**, click the **Align Right** button. This will place your text on the right edge of the page.

6. Click the *satsuki_azalea.jpg* image. Notice when you select an image to align with type, you have different alignment options available in the **Property Inspector**. The alignment options in this menu are strictly used when aligning text next to an image.
7. In the **Property Inspector**, choose the **Align** pop-up menu and select the **Left** option.

Notice that the text moves to the top-right of the image. Go ahead and play with the other align options to see how they affect the alignment of the text next to the image. Hey, if you don’t want to do that, just read the upcoming chart below to learn more. ;-) 

8. **Save** and **close** the file.
Aligning Text and Images

Dreamweaver MX offers many alignment options for text and images. The following chart defines all the alignment terms, so now you will know what you are requesting when you select one:

<table>
<thead>
<tr>
<th>HTML Text and Image Alignment Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alignment</strong></td>
</tr>
<tr>
<td>Browser Default</td>
</tr>
<tr>
<td>Baseline</td>
</tr>
<tr>
<td>Bottom</td>
</tr>
<tr>
<td>Absolute Bottom</td>
</tr>
<tr>
<td>Top</td>
</tr>
<tr>
<td>TextTop</td>
</tr>
<tr>
<td>Middle</td>
</tr>
<tr>
<td>Absolute Middle</td>
</tr>
<tr>
<td>Left</td>
</tr>
<tr>
<td>Right</td>
</tr>
</tbody>
</table>
Ordered, Unordered, and Definition Lists

In this exercise, you will learn how to create a variety of lists—an **ordered list**, an **unordered list**, and a **definition list**. These are HTML terms that refer to whether the list is formatted with a bullet, an indent, or Roman numerals. These lists can be generated from existing text or from scratch. Ordered, unordered, and definition lists remain part of the HTML 4.01/XHTML WC3 formal recommendations and will continue to be supported by Web browsers.

1. Open `text4.html`.

2. Select the four lines of text under the section called **Ordered List - Numbered**, which includes **Ordered item 1**, **Ordered item 2**, **Ordered item 3**, and **Ordered item 4**.
6. Typography | Dreamweaver MX H•O•T

3. Choose Text > List > Ordered List

```
Ordered List - Numbered
1. Ordered item 1
2. Ordered item 2
3. Ordered item 3
4. Ordered item 4
```

This is what an ordered list looks like.

4. Select the four lines of text under the Unordered List - Bulleted section (Unordered item 1, Unordered item 2, Unordered item 3, Unordered item 4).

5. Choose Text > List > Unordered List

```
Unordered List - Bulleted
• Unordered item 1
• Unordered item 2
• Unordered item 3
• Unordered item 4
```

This is what an unordered list looks like.

6. Select the four lines of text under the Definition List section (Definition item 1, Definition, Definition item 3, Definition).

7. Choose Text > List > Definition List

```
Definition List
Definition item 1
Definition
Definition item 3
Definition
```

This is what a definition list looks like.

8. Save the file and close it. You’ll find that knowing how to set up these different types of lists will come in very handy as you create your own Web pages and sites.
Color Schemes

Color schemes are preset groups of colors that Dreamweaver MX provides for your background, text, links, active links, and visited links colors. You can apply a color scheme to a page at any time. They are useful when you are not sure which colors to use. Why is this exercise in the “Typography” chapter? Because color schemes affect the color of type and links on your page, that’s why! You will learn how to control your own custom color schemes in Chapter 17, “Templates and Library Items.”

1. Open text5.html.

2. Choose Commands > Set Color Scheme.
3. In the **Set Color Scheme Command** dialog box, select **Green** under the **Background** option. Select **Brown, White, Green** under the **Text and Links** option. Click **OK**.

This is what the page looks like with the color scheme applied. If you do not like it, go ahead and choose another!
4. Choose **Commands > Set Color Scheme** again. Pick a different combination of colors and click **Apply**. Knock yourself out! (In other words, enjoy yourself.)

5. When you’re done having fun with colors, click **OK** and **save** and **close** the file.

---

**NOTE | Can I Create My Own Color Schemes?**

One question our students always ask is, “Can I create my own color schemes?” Well, the answer is yes and no. You can’t do it through the **Set Color Scheme** Command dialog box. However, you can do it by using templates, and we show you how in Chapter 17, “Templates and Library Items.”
Formatting Text in Tables

In this exercise, you will learn to change a table's type, style, color, alignment, and more. In the old days, which weren't so long ago, you would have had to edit each individual cell, one at a time, and it could have taken hours to edit a large table. Not anymore! With Dreamweaver MX, you can do it with a few deft clicks and drags.

1. Open text6.html.

2. Click in cell 1 in row 2 (Pine) and drag down to the last cell in the column (Maple).

   Note: You must be in Standard view to select a range of table cells.
3. In the **Property Inspector**, choose the **Font List** pop-up menu and select the **Verdana, Arial, Helvetica, sans-serif** font list. All the text in the selected column will update before your eyes. If you’ve ever hand-coded this sort of thing, you will be gasping in delight right now.

4. Highlight cell 1 in row 1 (**Plant**) and drag across to cell 4 (**Price**).

5. Using the **Property Inspector**, change the text style to **bold**.

6. Press **F10** to see the HTML. Look at all those **FONT** tags! Aren’t you glad you didn’t have to insert each one by hand? Press **F10** again to close the HTML panel.

7. **Save** and **close** this file.
6. Typography | Dreamweaver MX H•O•T

7. Applying HTML Styles

**HTML styles** are a great way to quickly format text in a document. You can save specific text formatting attributes and then apply them to any text on a page or within an entire site. Unlike Cascading Style Sheets, which require a 4.0+ browser, HTML styles will work in earlier browsers, which makes them an attractive option. In this exercise, you will format some text and create an HTML style based on that formatting. Then you will apply that formatting to other blocks of text on the same page. You will quickly begin to see how HTML styles can help automate simple text formatting.

1. Open *hstyles.html*. This document contains a lot of text, and it provides a good example of when you might want to use HTML styles to apply formatting across large amounts of text.

**NOTE | The Library Folder and HTML Styles**

As you begin working with HTML styles, you might notice a small addition to your local root folder. When you create your first HTML style, Dreamweaver MX automatically adds to your local root folder a Library folder, inside which you will see a *styles.xml* file. All of your HTML styles will be saved in that file. The file is important to the Dreamweaver MX internal workings, but it is not necessary to upload it when you publish your site to the Web. The folder does not hurt anything by residing in your Site window. In fact, it is a needed element to ensure that HTML styles will work properly.
2. Make sure your HTML Styles panel is open. If not, choose Window > HTML Styles. The shortcut keys are Ctrl+F11 (Windows) or Cmd+F11 (Mac).

3. Click and drag to select the word maintenance.

4. Using the Property Inspector, change the font to Verdana, Arial, Helvetica, sans-serif, the Size to 4, Bold, and the color to blue (any color of blue is fine).
6. Typography | Dreamweaver MX H•O•T

5. With your text still selected, click the New Style icon at the bottom of the HTML Styles panel. This will open the Define HTML Style dialog box, which allows you to define a style based on the selected text.

6. For Name, enter header. You can use any name you want here. Just use something that you will remember.

Tip: We recommend that you name your HTML styles relative to something that describes how they look. Because this text is formatted as a header, we named it header.
7. You can leave the rest of the options at their default values. Click OK. For an explanation of the options in the Define HTML Style dialog box, refer to the handy chart at the end of this section.

8. You should see your new style, header, listed in the HTML Styles panel.

TIP | Managing Your HTML Styles

As you begin working with HTML styles, you will no doubt want to go back and make changes to them. You might also want to delete ones you no longer need, make duplicates, and/or apply your styles. You can complete all of these tasks from the pop-up menu in the HTML Styles panel. This handy menu is your quickest path to managing your HTML styles.
6. Typography | Dreamweaver MX H•O•T

9. Select the word *Repotting* by clicking and dragging.

10. In the **HTML Styles** panel, click the style named **header**. This will format the selected text using the style you previously defined. Now, that is what we call quick formatting ;-)
11. Go ahead and repeat this process for **Watering**. When you are finished, your page should look like the one above.

12. Now the only real way you are going to learn this is by doing it on your own. So, see if you can make another HTML style and then apply that to the other paragraphs. Don't worry; if you get stuck, just refer to the beginning of this exercise.

13. When you are finished exploring this feature, **save** and **close** the file. You won't need it for future exercises.
Here is a quick definition for each of the options in the Define HTML Style dialog box:

<table>
<thead>
<tr>
<th>HTML Styles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>This is the name of your style that appears in the HTML Styles panel.</td>
</tr>
<tr>
<td><strong>Apply To: Selection</strong></td>
<td>With this option selected, the formatting will be applied only to the text you have selected.</td>
</tr>
<tr>
<td><strong>Apply To: Paragraph</strong></td>
<td>With this option selected, the formatting will be applied to everything within the paragraph (&lt;p&gt;) tag.</td>
</tr>
<tr>
<td><strong>When Applying: Add to Existing Style</strong></td>
<td>With this option selected, the formatting will be added to any formatting that has already been applied to the selected text.</td>
</tr>
<tr>
<td><strong>When Applying: Clear Existing Style</strong></td>
<td>With this option selected, the formatting will replace any formatting that has already been applied to the selected text.</td>
</tr>
</tbody>
</table>
### HTML Styles continued

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font Attributes: Font:</strong></td>
<td>This allows you to specify what font is used with the style.</td>
</tr>
<tr>
<td><strong>Font Attributes: Size:</strong></td>
<td>This allows you to specify what font size is used with the style.</td>
</tr>
<tr>
<td><strong>Font Attributes: Color:</strong></td>
<td>This allows you to specify what font color is used with the style. You can choose from the swatch or enter in a hexadecimal value.</td>
</tr>
<tr>
<td><strong>Font Attributes: Style:</strong></td>
<td>This allows you to specify which font styles (bold, italic, etc.) are used with the style. The Other pop-up menu displays less frequently used options.</td>
</tr>
<tr>
<td><strong>Paragraph Attributes: Format</strong></td>
<td>Available only if Apply To: Paragraph is selected, this lets you choose formatting options such as Heading 1, Paragraph, etc.</td>
</tr>
<tr>
<td><strong>Paragraph Attributes: Alignment</strong></td>
<td>Available only if Apply To: Paragraph is selected, this lets you specify the alignment settings for the style.</td>
</tr>
</tbody>
</table>
What Is Flash Text?

It’s pretty hard to be involved in Web design today and not hear the word “Flash.” It has become widely adopted in the Web design industry as an alternative and/or adjunct to HTML formatting. Macromedia Flash MX is a vector-based drawing, animation, and interactivity program. It can be used to create something as simple as a button for a Web page or as complex as an entire video game that can be played on the Web. Macromedia Flash MX uses a proprietary file format called SWF (pronounced “swiff”). Macromedia Flash MX content that gets uploaded to the Web always ends in the .swf suffix.

In order to view Macromedia Flash MX content on the Web, you must have the Flash MX plug-in installed in your browser. If you don’t have this plug-in, you can download it for free at http://www.macromedia.com/software/flashplayer.

The Flash Text feature in Dreamweaver MX lets you create text and text rollovers for your Web pages, using any font on your system, in the SWF file format. Flash Text is a good feature for creating text rollovers and small lines of text, such as headlines for your body text. It is not searchable by search engines and should not be used for large bodies of text. Before you move on to the exercise and learn the nuances of Flash Text, here’s a handy list that outlines some of the pros and one very big con of this feature.

<table>
<thead>
<tr>
<th>Using Flash Text</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Pros</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font integrity</td>
<td>With Flash Text, you can use any font installed on your system, and the visitors to your page don’t need to have that font installed, as they do with regular HTML text. This gives you much more flexibility when you are designing your pages.</td>
</tr>
<tr>
<td>Text rollovers</td>
<td>Creating text rollovers usually requires that you use a separate image editing program to create the necessary images. With Flash Text, you can create text rollovers without ever leaving Dreamweaver MX.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Con</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plug-in required</td>
<td>All Macromedia Flash MX content on the Web requires a plug-in to be viewed properly. Flash Text is no different and requires that the Flash plug-in be installed in the browser.</td>
</tr>
</tbody>
</table>
Creating Flash Text

In this exercise, you'll get to use Flash Text. Flash Text lets you use any font you want without worrying whether the visitors to your site will have it installed on their systems. It also lets you easily create rollovers without using any JavaScript. It's really easy to learn and use—read on and try it out to see what we mean!

1. Open flashtext.html. This page contains a simple layout that was created using tables to control the position of the images on this page. You will learn more about tables in the next chapter, we promise!

2. Click inside the first cell at the top. This will place a blinking I-beam cursor in that cell and lets Dreamweaver MX know that this is where you want to place your object, which is Flash Text in this case.

3. From the Media tab in the Insert panel, click the Flash Text icon. This will open the Insert Flash Text dialog box.
4. Select a font for your text from the **Font** drop-down menu. We are using a font called SimSun. You can use whatever font you want. The point is to use a font that isn’t common to that many people. Make sure you choose a font that you don’t think end users will have on their computers. One of the advantages of using Flash Text is that the font is embedded in the SWF file and does not have to be installed on the end user’s computer. So, now you can feel free to use just about any font you have on your computer!

5. Set the **Size** option to **25**. This option sets the size of your text in points. Click the **Bold** button to make the text bold.

6. Click the **Color** option and select an olive color. We used **#999933**, but you are welcome to use any color you like.
7. Click the Rollover Color box and select a bright orange color. Setting this color will automatically create a rollover effect for your Flash text. Pretty simple, huh? ;-)

8. In the Text field type art of bonsai. By default, the Show Font checkbox is checked; this will give you a preview of the text in the font you selected. If the font you selected is not being displayed, make sure the Show Font checkbox is checked.

Warning: This dialog box will not give you a preview of the size you specified; you can only see the actual size in the document itself. We think that it would be nice if the next version let you preview the size of your text in this dialog box.
6. Typography | Dreamweaver MX H•O•T

9. Click the Bg Color color box and move the eyedropper over the background of the document window and click. This will let you sample and select the background color of your page so that it matches the background color of your Flash Text.

10. In the Save As field, type art_bonsai.swf. Good file management principles dictate that you give your files names that reflect their content. Note: If you are using a Mac with OS X, you should click Browse before entering the name for the SWF file.

Notice that you can easily add a link to the Flash Text using the Link field option.
11. Repeat Steps 2 through 10 to create Flash Text for **how to bonsai, tools and supplies, resources, photo gallery, and contact info**. When you’re finished, your page should look similar to the one shown below.

![Flash Text Example](image)

This is what your page should look like when you are done. Remember, we used the SimSun font, so yours will display whatever font you selected.

12. Press **F12** to preview your page in a browser. Return to Dreamweaver MX and **save** the changes to this file. You can **close** this file; you won’t be working with it any longer.

Woo-hoo! You are done with another chapter; you can take a nap or keep on moving to the next chapter! I don’t know about you, but we sure could use a little nap after all that talk about text. ;-)